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Acronyms, Units and Currencies 
 

AADT  Average Annual Daily Traffic BC Bituminous Concrete BUET  Bangladesh University of Engineering and Technology CBA Cost Benefit Analysis CC Cement Concrete CVD Commercial Vehicles per Day DURP  Department of Urban and Regional Planning EIRR  Economic Internal Rate of Return GIS Geographical Information System HBB Herring Bone Bond (brick pavement) HQ Head Quarters LGED  Local Government and Engineering Department MCA Multi-Criteria Analysis RCC Reinforced Cement Concrete RDBMS Road Database Management System ReCAP Research for Community Access Partnership RHD Roads and Highways Department SDG Sustainable Development Goal                                
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Terms Used in the Guide 
 AADT Average Annual Daily Traffic volume of a road. 
Core Road Network A network of important roads to maintain inter- and intra-upazila 

road connectivity. The activity centres form the nodes and roads 
connecting them are the links of the core network. In the 
prioritisation scheme used by RPPM all such roads are given 
additional importance. The core network comprises of RHD roads in 
an upazila (if any), all upazila and union roads and some village 
roads. 

Cost Benefit Analysis (CBA) A procedure for evaluating the economic desirability of developing a 
road by comparing its total benefits with total costs for 
development. Results of may be expressed in many ways including 
Economic Internal Rate of Return (EIRR), Net Present Value (NPV), 
and Benefit Cost Ratio (BCR). 

Earth road An unpaved road; also referred to as “Kutcha Road”.  
Facility Score The score of a road considering the facilities served by the road. It is 

determined by considering the weight and number of facilities 
served by a road.  

High volume earth road  Earth road which have AADT value over 200. 
Local Workshop Workshop organised at the upazila level to collect some data for 

RPPM. 
Low volume earth road  Earth road which have AADT value less than or equal to 200. 
Multi-Criteria Analysis (MCA) A prioritisation procedure for appraising the total effect of a number 

of criteria or factors considering their relative importance. RPPM 
uses a set of criteria for each type of road development.   

Road database The road inventory database maintained by LGED. It contains 
engineering survey data, traffic survey data, information on 
maintenance, socio-economic facilities and other information of 
roads developed and maintained by LGED.  

Union road Roads connecting Union HQ/s with Upazila HQs, growth centres or 
local markets or with each other. 

Upazila road Roads connecting Upazila HQs with growth centres or one growth 
centre with another growth centre by a single main connection or 
connecting growth centre to higher road system.  

Village road A Roads connecting villages with Union HQs, local markets, farms and 
ghats or with each other. 

Village road B   Roads within a village. 
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1 Introduction 
1.1. Introduction 

The Rural Road Planning and Prioritisation Model (RPPM) software has been developed for planning 
and prioritisation of rural roads developed and maintained by the Local Government Engineering 
Department (LGED). It is developed as a web-based application tool run from the GIS web portal of 
LGED. This guide is intended to assist LGED officials in using RPPM. It also provides guidance on how 
to prepare data for use by RPPM. 
 
RPPM is based on the methodology developed for the project “Planning and Prioritisation of Rural 
Roads in Bangladesh”. The project was implemented under the ReCAP research programme funded 
by UK Aid. The details of the methodology may be found in the Final Report of the project 
(http://www.research4cap.org/Library/DURP-BUET-2017-PrioritisationRuralRoads-
FinalReportVolume1-AsCAP-BAN2072A-171105.pdf). 
  
RPPM can prioritise development for three types of road development works undertaken by LGED, 
namely, improvement, further improvement (upgrading of an existing paved road) and maintenance 
of rural roads. The definitions of these terms are as follows:  
 
Improvement  

 converting an earth road to a paved road i.e., from earth to BC/RCC in an existing alignment; 
 converting a partly paved road to a fully paved road; and 
 converting a HBB road to a fully paved road. 

 
Further Improvement/Upgrading 

 improvement of road geometric standards, raising of embankment and widening of 
pavement and/or road crest and raising of road embankments of an existing road. 

 
Maintenance 

 maintenance of an already paved or partly paved road (BC, RCC or HBB). 
 

Using data from the road inventory and GIS databases of LGED, RPPM can perform the following 
tasks. 

 Prepare prioritised lists of different types roads for improvement. 
 Prepare prioritised lists of different types of roads for further improvement/ upgrading. 
 Prepare prioritised lists of different types of roads for maintenance. 
 Generate a score table with basic information, details of priority scores, and CBA and MCA 

results of a road, and generate their rankings. 
 Generate the Core Road Network of an Upazila. 

All lists are prepared both in tabular and in map form.  
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1.2. Intended Purpose 
After using the Guide, a RPPM user will  

 have understanding about RPPM and the tasks that it can perform 
 learn how to use RPPM and generate outputs 
 know how to save outputs and extract the required information to prepare reports  
 learn the data requirements of RPPM, the sources of data and how to collect additional data 

that are not available in the road database. 
1.3. Symbols Used in the Guide 

Table 1.1: Meanings of different symbols used in the Guide 
Symbol* Means 
Module Modules of the Tool  
Menu Menu under module of the tool 
Submenu Submenu within Menu 
Button Button within program or Menu or drop-down menu 
Procedure  Procedure for conducting any tasks in RPPM 
Table Table in Database or output 
Tab Tab in menu 
Field Field in a Table or in a Tab 

*Throughout the User Guide symbols are presented/ written in the same way (bold, italic, underlined etc.) as shown in the table. 
1.4. Organisation of the Guide 

There are five chapters in this Guide. The first chapter provides a short description of the software 
(RPPM) and this Guide. The second chapter provides the description of the user interface of the 
software. The following two chapters provide the description of using the software in different 
operating modes. The fifth chapter provides the description of the required data and how to 
configure the tool. The first appendix provides the description of the method for collecting required 
data from local workshop, while the second appendix provides the data collection tool to be used in 
the workshop. 

1.5. Target and users of the Guide 
The User Guide is developed for the concerned LGED officials at Head Quarters and local levels who will consider and plan rural roads in Bangladesh for development based on their merits as reflected in the prioritised scores generated by Rural Road Planning and Prioritisation Model (RPPM).   
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2 Getting Started 
 Objectives of the Chapter 
 After reading the chapter a RPPM user will 

 learn how one can access and use RPPM 
 understand the user interfaces of RPPM 
 be familiar with the main menus of RPPM and the tasks that it can perform. 

2.1. User Type 
RPPM is a web-based application, integrated as a tool within the GIS web portal of LGED. It has been 
developed for internal use of LGED and, therefore, it’s access is controlled. There are two types of 
RPPM users: privileged users and common users. A privileged user has access to the LGED server to 
configure some default parameter values used by RPPM, and run the program to generate outputs 
at upazila and district levels. It is expected that they will be officers at the Planning, Design and 
Procurement, and Maintenance, Asset Management and Road Safety departments at the LGED Head 
Quarters. A common user can see the outputs for an upazila or a district for which the program has 
already been run, and generate and print the output tables and maps as required. However, a 
common user will not be able to run the program or change the default parameter values used by 
RPPM.  

2.2. Programme Loading 
To use the application, enter into the GIS web portal (http://www.gis.lged.gov.bd/) of LGED (Figure 
2.1). To get access to the web portal to run RPPM, one has to login (marked in red in Figure 2.1).  

 
Figure2.1: GIS web portal of LGED 
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After entering the GIS web portal, the logon window appears on the screen (Figure 2.2). Type your 
user id and password to log into the system. If you want to avoid logging every time you want to be 
in the portal check remember me. However, for security reason, checking remember me is not 
recommended. 

Figure 2.2: Log on Screen 

 
2.3. User Interface 

Once you are logged in the system, you can find the browser as shown in Figure 2.3. This is the home 
screen of RPPM. The three modules – “Project Data”, “Road Priority” and “Map” of the portal are 
located in this screen. Road Priority and Map contain all the features of RPPM. This chapter provides 
the detail descriptions of those features. The Project Data module is not part of RPPM and it 
performs tasks that are beyond the scope of RPPM.  
 

Figure 2.3: Home Screen of RPPM 
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2.3.1. Road Priority Module 
The Road Priority module generates prioritised lists of roads for improvement, maintenance and 
further improvement in tabular form. A privileged user can also change the default parameter values 
used by RPPM from this module.  
 
Once you are in Road Priority module, the opening window appears as shown in Figure 2.4. It has 
four major blocks (Header, Selection menu, Task menu and Configuring menu) as marked 
in the Figure 2.4. 
 

Figure 2.4: Opening Window of Road Priority 

 The Header has two buttons (Figure 2.4.1). The home button takes you to the home screen of RPPM 
(Figure 2.3). The user icon highlighted in green shows the name of the user who logged in the 
system. 

 
Figure 2.4.1: Detail of Header 

  
 
 
 
 
 
 
 
 
 
 
 
 

Header  Selection Menu 
Task Menu Configuring Menu 

Home User 
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The Selection menu (Figure 2.4.2) helps the user to select the geographical entity (upazila or 
district) for which RPPM is to be run. There are interconnected drop down menus for selection of 
division, district and upazila. It may be noted here that after typing the first letter of the name of the 
geographic entity all the geographic entities which start with the same letter appear in the list. 
 

Figure 2.4.2: Detail of Selection Menu 

  
 
 
The Task menu contains four drop down buttons (Figure 2.4.3). Of these buttons, some contain 
further options which are discussed in chapter five. The Task menu is used for generating lists of 
roads for development. 
 

Figure 2.4.3: Detail of Task Menu 
 

 
 

 
 
The Configuring menu contains two options (Figure 2.4.4). Start Process is a drop-down menu 
where configuration is a single option tool. This menu is accessible only to the privileged users.  
 

Figure 2.4.4: Detail of Configuring Menu 
 

 
 

 
 
 
 
 
 
 
 

Drop Down Menu for Selecting Districts 
Drop Down Menu for Selecting Division Drop Down Menu for Selecting Upazila 

Drop Down Menus of Task Menu 

Drop Down Menu of 
Configuration Menu 
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2.3.2. The Map Module 
In the Map module a user can visualize the results of tasks performed by RPPM on a map. There are 
two features in the Map module which are not available in the Road Priority module. The first is 
needed to visualize the results; and the second is for viewing results for multiple upazilas. The Map 
module is divided into five major blocks as marked in figure 2.5.  
 

Figure 2.5: The Map Module 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Starting and closing menus contain the title of the page and menu selection of the 
geographic unit and export options. There are three drop down menus (Figure 2.5.1) for selecting a 
geographic unit, and buttons for saving and exporting results (Figure 2.5.2). There are also buttons 
for returning to the opening screen of RPPM (Figure 2.5.1) and logger’s information (Figure 2.5.2). 
 

Figure 2.5.1: Drop Down Menu for Selection of Geographic Unit 
  

 
 
 

Figure 2.5.2: Save and Export Button 
  

 
 
 

Selection of Geographic Unit Home Button 

Save Button 
Export Button Logger’s Name 

Starting and Closing Menu 
Editing Menu 

Map Window Tools Menu 
Road Information Window 
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There are six tools in Tools menu of the Map Module. The RPPM tool is the rightmost tool in the 
tools menu (Figure 2.5.3). It gives ten options to display (Figure 2.5.4). 
 

Figure 2.5.3: RPPM Tool in the Tools Menu of the GIS Portal 

  
 

Figure 2.5.4: Sub Menus of RPPM tool 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

RPPM Tool 
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In the Editing menu there are two tabs (Figure 2.5.5 and Figure 2.5.6). In the Layer tab (Figure 
2.5.5), you can select/deselect layers for display and edit display parameters. There are buttons for 
zooming and getting information on the active layer in this tab. You can select road(s) based on 
criteria by using Search tab (Figure 2.5.6). The result of the search is shown at the bottom of the 
Search tab. 

 
Figure 2.5.5: Layer Tab of Editing Menu 

 

  
Figure 2.5.6: Search Tab in Editing Mode 

 

  
 
 
 
 
 
 
 
 
 
 
 

Layer Tab 

Active Layer Information Button 
Zooming Button 

Layers to select / deselect 

Search Parameters 

Search Tab in Editing Menu 

Search Result 

Button to hide/unhide editing menu  
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The map window is for viewing the results with the information in the desired layer(s). The window 
has zooming options (Figure 2.5.7). The window also shows scale and north direction of the map. 

 
Figure 2.5.7: Map Window 

  
There are two tabs in the road information window (Figure 2.5.8). The Attributes tab shows the data 
(for example, road id, road name, road type, road surface, EIRR value etc.) of the selected road for a 
particular type of development. The Road Summary tab provides some of the most important data 
for the selected road. 
 
You may note that the editing tool window and road information windows can be viewed using the 
arrow button. 
 

Figure 2.5.8: Road Information Window 
 

  
  

Zooming Button 

North Direction 
Scale 

Hide/view button 

Road Summary Tab 

Attribute Tab 
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3 Generating RPPM Outputs in Tabular Form 
Objectives of the chapter 

After reading the chapter a RPPM user will learn: 
 about the tools used in generating priority lists of roads for development 
 to generate roads included in the core network of an upazila 
 to generate prioritised list of different types of road development (improvement, 

further improvement/upgrading or maintenance). 
3.1. Introduction 

RPPM generates prioritised lists of roads for development both in i) tabular and ii) graphical (map) 
forms. For generating output in tabular form, you have to be in the Road Priority module. You can 
generate the following outputs in tabular form (Table 3.1). 
 

Table 3.1: Prioritised list of roads by development and surface type 
Priority list Development Type Surface Type 
1 

Improvement 

Low Traffic Volume Earth Roads 
2 High Traffic Volume Earth Roads 
3 Partially Paved 
4 Fully HBB 
5 

Maintenance 
Partially Paved 

6 Fully HBB 
7 Fully Paved 
8 Further 

Improvement/upgrading 
Fully paved (Full BC/RCC, HBB + BC/RCC) 
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3.2. Generating the Lists of Roads 
To generate the prioritized list of roads, you have to select Task menu (Figure 2.4). There are four 
drop down submenus in the Task menu (Figure 2.4.3). There are sub-menus in three of the four 
drop down submenus of the Task menu (Figure 3.1.1 to Figure 3.1.3). The submenus initially 
dictate the development type then the surface type. For earth road, two lists are generated for 
improvement on the basis of AADT. 
 

Figure 3.1.1: Submenu of Improvement 

 
 

Figure 3.1.2: Submenu of Maintenance 
 

 
 

Figure 3.1.3: Submenu of Further Improvement 
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Once you choose any of the options the browser window appears like Figure 3.2. The description of 
Header is already provided in section 2.3.1. The window contains the selection menu, 
configuring menu and task menu which are described in sections 2.3.1. The title shows the task 
performed by the select option while output window shows results of the task. 
 

Figure 3.2: Window after activating option for generating list for Improvement 

 
Support tools are used to perform some other related tasks. The following paragraphs provide 
description of these tasks. It should be mentioned here that an upazila must be selected from the 
selection menu before selecting any options of the select option menu. 
 
There are five tools (Figure 3.2.1) in the support tools. The leftmost one is for viewing the number of 
pages. If the output size is too long to show in one output window at a time, it shows the total 
number of output windows RPPM needs to show all results. The number in the box shows the serial 
number of the window it is showing. 
  

Figure 3.2.1: Support Tool 

  
 
 

 
 
 
 
 
 

Header 

Output 

Title Support Tools 

Save Button 
  

No of Pages to View Button Search Button 
Refresh Button 

Print Button No of window showing the result 
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The next one is a search tool that you may use to search by road code or road name. The third tool is 
to save the results. It is a drop-down tool (Figure 3.2.2). It can save the results of the task either in a 
word (*.docx), spreadsheet (*.xlsx) or portable document (*.pdf) format. The fourth one is the 
refresh button. This button is useful for privileged users to check the variations resulting from 
changes, made during configuration (Chapter Five), in the default parameter values. The fifth and 
rightmost tool is the print tool for printing the results. 
 

Figure 3.2.2: Save Tool 

 It may be noted here that if there is no output for a particular task, RPPM provides message “There 
is no road in this category” in the browser window (Figure 3.2.3). 
 

Figure 3.2.3: Screen of Browser if there is no road for selected type of development 

 
3.3. Generating List of Roads in Core Network 

Selecting the Core Road Network from Select Option provides the list of roads which constitute the 
core road network of an upazila (Figure 3.3). The list shows the road code and name of the road 
along with the district and upazila name. 

Figure 3.3: Core Road Network 
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3.4. Generating Lists for Improvement of Roads 
Four prioritised lists of roads for improvement can be generated depending upon road surface type 
and traffic volume. The generated lists (Figure 3.4.1 – Figure 3.4.4) show priority ranking, road code, 
road name, and other related information of the road that has been used for producing the list. In 
addition, the output window provides the information on district, upazila, surface type and type of 
development.  
 
It may be noted here that for low traffic volume earth roads the ranking is based on MCA scores.  
 
Procedure for identifying low traffic volume earth road for improvement is as follows (Output 
window is shown in Figure 3.4.1). 

 
Select Option > Improvement >Low Traffic Volume Earth Roads 

Figure3.4.1: Output Window Showing Priority List for Improvement of Low Traffic Volume Earth Road 
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Procedure for identifying high traffic volume earth road for improvement is as follows (Output 
window is shown in Figure 3.4.2). 

 
Select Option > Improvement > High Traffic Volume Earth Roads 

Figure 3.4.2: Output Window Showing Priority List for Improvement of High Traffic Volume Earth Road 
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Procedure for identifying partially paved road for improvement is as follows (Output window is 
shown in Figure 3.4.3). 

 
Select Option > Improvement > Partially Paved 

Figure 3.4.3: Output Window Showing Priority List of Improvement for Partially Paved Road 

 
 

Procedure for identifying Fully HBB road for improvement is as follows (Output window is shown in 
Figure 3.4.4). 
 

Select Option > Improvement > Fully HBB 
Figure 3.4.4: Output Window Showing Priority List for Improvement for Full HBB Road 
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3.5. Generating Lists for Maintenance of Roads 
For paved, partially paved and HBB roads, RPPM generates outputs with list of roads for 
maintenance from select option menu (Figure 3.1.2). The output window shows Ranking, Road 
Code, Road Name, and other information (Figure 3.5.1-3.5.3). Information on district, upazila, 
surface type and type of development are shown at the top of the lists for maintenance. The ranking 
is done on the basis of MCA scores. 
 
Procedure for identifying partially paved roads for maintenance is as follows (Output window is 
shown in Figure 3.5.1). 
 

Select Option > Maintenance > Partially Paved 
Figure 3.5.1: Output Window Showing Priority List for Maintenance of Partially Paved Roads 

  
Procedure for identifying HBB roads for maintenance is as follows (Output window is shown in 
Figure 3.5.2). 

 
Select Option > Maintenance > Fully HBB 

Figure 3.5.2: Output Window Showing Priority List for Maintenance of Fully HBB Roads 
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Procedure for identifying paved roads for maintenance is as follows (Output window is shown in 
Figure 3.5.3). 

  
Select Option > Maintenance > Fully Paved 

Figure 3.5.3: Output Window Showing Priority List for Maintenance of Fully Paved Roads 

 
3.6. Generating Lists for Further Improvement/Upgrading 

RPPM can generate output with list of roads for further improvement/upgrading from the select 
option menu (Figure 3.1.3). The browser window looks like figure 3.6 when further improvement is 
selected from the select option menu.  
 
Procedure for identifying roads for further improvement is as follows (Output window is shown in 
Figure 3.6). 
 

Select Option > Further Improvement> Full BC/RCC, HBB+BC/RCC 
 

Figure 3.6: Output Window Showing Priority List of Roads for Further Improvement 
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4. Generating Map Output 

Objectives of the Chapter 
After reading the chapter a RPPM user will learn  

 about the tools in the Map Module used to generate priority lists of roads 
 to generate Core Road Network of an upazila or some selected upazilas 
 to generate maps for different types of road development (improvement, further 

improvement/upgrading or maintenance). 
4.1. Introduction 

RPPM can show the generated prioritised list of roads on a map. The Map module is open for all. 
Any user can see the outputs. However, only privileged user can edit maps. 

4.2. Mapping the Roads for Development 
RPPM is available from the tools menu of the MAP module (Figure 2.5) of the GIS web portal. As 
mentioned earlier, the module has 10 radio buttons (Figure 2.5.4), which help you to choose the 
map to be generated. Once you select the RPPM, the other tools of the web portal become inactive. 
To deactivate RPPM tool, select none. For visual clarity, after selecting the option of development, 
close the menu which pops up after selecting the RPPM application. Similar to the Road Priority 
module, the geographical unit must be selected before activating RPPM tool. A geographical unit of 
interest can be selected from selection menu (Figure 2.5) located at the top half of map window.  
 
You can view the map outputs for multiple upazilas in a single window (Figure 4.1) in Map module 
unlike the Road Priority module which can show the output of a single upazila in a window. 
 
There are six tools in the Tools menu of Map module – RPPM tool is at the rightmost tool. From the 
submenu of RPPM tool maps of Core Road Network, different types of roads considered for different 
types of development can be selected.   
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Procedure for mapping the Core Road Network is as follows (Output window is shown in Figure 
4.1.1). 
 

RPPM Tool > Core Road Network 
Figure 4.1.1: Map Window Showing the Core Roads Network 

  
 
Procedure for mapping the Low Traffic Volume Earth Road for Improvement is as follows (Output 
window is shown in Figure 4.1.2). 

 
RPPM Tool > Improvement > Low Traffic Volume Earth Road 
 Figure 4.1.2: Map Window Showing the Low Volume Roads for Improvement 
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Procedure for mapping the high traffic volume earth road for improvement is as follows (Output 
window is shown in Figure 4.1.3). 

 
RPPM Tool > Improvement > High Traffic Volume Earth Road 

Figure 4.1.3: Map Window Showing the High Traffic Volume Earth Road for Improvement 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Procedure for mapping the partially paved roads for improvement is as follows (Output window is 
shown in Figure 4.1.4). 

 
RPPM Tool > Improvement > Partially Paved Road 

 

Figure 4.1.4: Map Window Showing the Partially Paved Roads for Improvement 

  



Planning and Prioritisation of Rural Roads in Bangladesh 

Page29 
  

 
 
Procedure for Mapping the HBB roads for improvement is as follows (Output window is shown in 
Figure 4.1.5). 

 
RPPM Tool > Improvement > HBB Roads 
 

Figure 4.1.5: Map Window Showing the HBB Roads for Improvement 

  
Procedure for mapping the partially paved roads for maintenance is as follows (Output window is 
shown in Figure 4.1.6). 

 
RPPM Tool > Maintenance > Partially Paved Roads 

Figure 4.1.6: Map Window Showing the Partially Paved Roads for Maintenance 
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Procedure for mapping the HBB Roads for maintenance is as follows (Output window is shown in 
Figure 4.1.7). 

 
RPPM Tool > Maintenance > Full HBB Roads 

 

Figure 4.1.7: Map Window Showing the HBB Roads for Maintenance 

  
 
Procedure for mapping the paved roads for maintenance is as follows (Output window is shown in 
Figure 4.1.8). 

 
RPPM Tool > Maintenance > Paved Roads 

 

Figure 4.1.8: Map Window Showing the Paved Roads for Maintenance 
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Procedure for mapping the Roads for Further Improvement is as follows (Output window is shown in 
Figure 4.1.9). 
 

RPPM Tool > Further Improvement > Full BCC HB Roads 
 

Figure 4.1.9: Map Window Showing the Roads for Further Improvement  

  
In the map window, roads are grouped according to their EIRR values or MCA scores. Maps showing 
roads identified for improvement or further improvement/upgrading (High Traffic volume earth 
road, HBB road and partially paved roads, and paved roads), the grouping of roads are according to 
their EIRR values. In maps for maintenance and Low Traffic Volume Earth Roads, the grouping of 
roads is based on their MCA scores. 
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4.3. Extracting Data of Mapped Road 
A user has two options to extract data of roads shown in a map: view the data in road information 
window (Figure 2.5.8) or in a .pdf file (Figure 4.2.1). The first option is applicable when RPPM is not 
in active mode, while the second option is available when RPPM is activated. It should be mentioned 
here that these options are not applicable in case of core road network. 
 
When a road is selected on a map, you can see its information in a road information window. 
Depending upon the type of road, several tabs may be available under the attribute tab. The road 
summary provides detaild data on the road, which can be exported as an excel sheet and saved. 
When RPPM is activated, selecting a road on map results in a pop-up (Figure 4.2.1). The pop up 
shows the value of different parameter values used in EIRR and MCA calculations and physical and 
traffic data of the selected road. The information on the pop-up window can be saved (the save 
button is marked in Figure 4.2.1) in .pdf, .xlsx or .docx format.  
 

Figure 4.2.1: Pop-up of Priority Score and Ranking Detail of Road  
 

  
A user with access to the GIS server (that is a privileged user) can use this modality to extract and 
use the detailed data of a road to generate a report. The contents of the generated report are shown 
in Fig. 4.2.1 
 
 
 
 
 
 
 
 
 
 
 

Save button 
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Procedure for generating priority score and ranking of a single road is as follows (Output window is 
shown in Figure 4.2.2). 

 
Select Road >Double Click  
 

Figure 4.2.2: Report of Priority Score and Ranking of a Road Generated by RPPM 
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4.4. Editing the Maps 
You can change the display or printing features of maps by adding/removing layer(s), change of 
colour and appearance of map features. You can also save and export the generated results. 

4.4.1. Adding/Removing a Layer 
The default setting of display in Map module is the last active layer(s). Running RPPM adds one 
added layer showing the results. If a user wants some additional layer(s), they can be added. 
Similarly, some active layer(s) can be removed if desired (Figure 4.3.1) 
 
Procedure for Adding Layer 

 
From the Editing Menu check the layer to add 

 
Procedure for Removing Layer 

 
From the Editing Menu uncheck the layer to add 

 
Figure 4.3.1: Adding/ Removing Layer 

 

  
 

4.4.2. Editing the Display Properties of Map Feature 
RPPM shows the roads in core road network according to official categorization of roads by LGED. In 
addition, it shows the road code. RPPM categorizes selected roads for any type of development 
according to their MCA scores or EIRR values that has been used for ranking. A user can change the 
appearance of map features.  
 
 

Check for selection of Layer 

Uncheck for non-selection of Layer 
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Procedure for changing the properties of map features 
 

1. Select the layer. The layer would be highlighted (Figure 4.3.2) 
 

Figure 4.3.2: Identifying layer 
 

 
 
 
 
 
 
 
 
 
 
 

2. Double clicking the layer will show a popup window with display property 
(Figure 4.3.3). Select classifier tab (Marked in Figure 4.3.3). 

Figure 4.3.3: Display Property Popup 
 

 
 
 
 
 
 
 

 
 
 
 
 
 
 

Identified Layer 
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3. Depending upon the variable by which map the feature is displayed, in classifier 
tab there may be a division field (Marked in Figure 4 .3.4). 

Figure 4.3.4: Properties of Classifier Tab 

  
a. A user can increase or decrease the value of division which will change number 

of classes in the displayed map. 
b. The alias field will display the title of the class while the Min and the Max are the 

minimum and maximum values of the class. Minimum and maximum values can 
be changed either by typing the value or using the up or down arrows. 

c. Double clicking the colour of any class change the display of classifier tab (Figure 
4.3.5). A user can change the colour by typing color code (marked) or from color 
palate (by double clicking the color). Similarly, change the width by typing 
(marked) or changing the value in linear scale (marked). For changing the line 
dash type there is a drop-down menu. 

Figure 4.3.5: Properties of Classifier Tab after double clicking colour of any class 

  

Typing button for changing colour 

Drop down menu for selecting line dash type 
Typing button for changing line width 

Button for opening colour palate 

Linear scale for changing Line Width 
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d. Once you are satisfied with the display settings choose the save button to bring 

the changes in display. 
4.4.3. Exporting and Saving Map 

You can export the generated maps in pdf format from the GIS Portal by selecting Export Map from 
starting and closing menu. A preview of the map layout will open in a separate tab as a pdf file 
in the browser (Figure 4.4). If acceptable, then download the file and save it or alternatively selecting 
save button from starting and closing menu will save the map in jpeg format. 
 
It may be mentioned here that if the browser blocks the popup window the export map option will 
not function. 
 
Procedure for exporting and saving map 

 
starting and closing menu> Export Map> Download 

 

Figure 4.4: Saving and Exporting Map 

 
  Download Button Print Button 
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5. Data Requirements for RPPM 
Objective of the Chapter 

After reading this chapter a RPPM user will  
 understand the types of data required to run RPPM 
 know the source of data and their storage in the road database 
 learn how to prepare data for RPPM 
 learn how to change/configure the default parameter values of RPPM 

5.1. Data Requirements for Running RPPM 
RPPM uses data from the road database of LGED to calculate MCA and EIRR values. Table 5.1 shows 
the required data for RPPM including the mode for data collection and updating. The information 
available in the GIS database is used for generating maps. 

Table 5.1: Required Data for RPPM 
Data on Mode of Data Collection/Updating 

Growth Centre and Rural Markets 

Regular updating process of LGED 

Position of Growth Centre and Rural Markets on Roads 
Physical and Traffic Features of Road 
Socio-Economic Facilities (except market and growth 
centre) along the road.  
Segment-wise Physical Feature Information of Road 
Segment-wise Physical Condition Information of Road 
Mode-wise Traffic Volume Data on the Road 
Local priority  

Local Workshop Connectivity 
Road Safety 
Vehicle Operating Cost, Standard Speed (km/hour), 
Value of Time (Tk/hour) in different roughness 
conditions 

GIZ, 2009 

Road Construction Cost, Routine Maintenance Cost and 
Periodic Maintenance Cost of Roads 

Planning, Design and Procurement, 
and Maintenance Department of 
LGED; 
Asset Management and Road Safety 
Department of LGED 

Consumer Price Index Statistical Yearbook published by the 
Bangladesh Bureau of Statistics  

 
The existing road database contains most of the required data in different tables. Table 5.2 provides 
the list of tables that hold the data. However, two new tables (Vehicle Attribute and Road field 
data) are to be created and appended to the Road database before running RPPM. These two tables 
contain data that are not available in the existing road database. 
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The Vehicle Attribute table contains values of vehicle operating cost, standard speed (km/hour) and 
Value of Time (Tk/hour) in different roughness conditions for 15 types of vehicles that operate on 
rural roads of Bangladesh. These values are used for CBA calculation. The values for this table are 
extracted from a GTZ study for LGED (GTZ, 2009). These values need not to be changed in the near 
future. The values in this table can be changed when new values are available. 
 
In the Road field data table there are 12 fields (Figure 5.1). Of these 12, six fields (the six left most 
columns of the figure) are identifiers for the road while for the five right most fields data have to be 
collected from local workshops. No action is needed on field 7. The five right most fields contain the 
data on connectivity; local priority and road safety (see details in Appendix A). After collecting data 
on these items from local workshops in a district, this table has to be created and appended to the 
database before running RPPM for the district.  

Figure 5.1: Structure of Road Field Database 

 Source: LGED, 2017  
RPPM uses seven tables of the existing road database (Table 5.2). These tables contain engineering 
survey data, traffic survey data, maintenance information and information on socio-economic 
facilities. The data listed in this table are regularly collected by LGED. 
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Table 5.2: Table of the Road Database Used by RPPM 

Contains Data On Data Table Data Field Used in RPPM 
Data on Growth Centre and Rural Markets GC_SM_List  Gc_SM_ID,  

 GC_SM_Tag 
Data on Position of Growth Centre and Rural 
Markets on Roads 

RoadGC_SM_ 
Position  GcOrHatID 

Data on Physical and Traffic Features of Road RoadInventory 
 RdTypeCode, 
  AADT_MT,  
 AADT_NMT,  
 CVD,  
 IRI 

Data on socio-economic facilities (except market 
and growth centre) along the road.  RoadSocioConn  Socio_Sl,  

 S_Type_ID 
Segment wise physical feature information of road RoadSegments  SurfType 

Segment wise physical condition information of 
road RoadSegCond 

 Rutting_L,  
 Rutting_H,  
 Depression_L,  
 Depression_H,  
 Ravelled_L, 

Ravelled_H,  
 Crack_L,  
 Crack_H,  
 PotHole_L,  
 PotHole_H,  
 EdgeDistress_L,  
 EdgeDistress_H 
 E_Date 

Mode wise Traffic Volume data on the road RoadTrafficCou
nt 

 VehiID,  
 CountHatDay,  
 CountNonHatDay 

5.2. Data Preparation  RPPM uses data from both the road and GIS databases.  The data mentioned in Table 5.1 are 
regularly collected by LGED. But data for the two tables (Road field data and Vehicle Attribute) need 
to be prepared before RPPM can be run for a district/upazila. Of these two, data for the Vehicle 
Attribute table may remain the same for all districts for some years and may not need updating. 
However, the Road field data table has to be created after organising local workshops (see Appendix 
A) for a district before RPPM can be run for that district. 
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5.3. Editing/Changing Default Parameter Values 
 A privileged user, if necessary, can change the default parameter values using the Configuration 
Menu (Figure 2.4.4). The Configuration menu has two buttons: i) start process and ii) configuration 
to run the application.  
 
Some parameter values used in CBA may vary by district or upazila. They may also vary over time. 
For example, road construction and maintenance costs may vary by district. They are also expected 
to change over time. The Consumer Price Index (CPI) value, tax rate and annual cost increments may 
also change from year to year. Before running RPPM, the default/current values for all such 
parameters should be reviewed by the user and changed, if necessary. 
 
If any of the default values need to be changed, select configure button (Figure 2.4.4). A window 
would pop up (Figure 5.2). The values displayed in the pop up window are the default/current 
values. 

 
Figure5.2: Pop-up Window for Changing Parameter Values 

 
Once the new parameter values are available for a district or an upazila, select Start process (marked 
in red in Figure 5.3) to initiate the application. However before initiating the program choose the 
district and upazila from selection menu (Figure 2.4.4) for which the application is to be run. You can 
run the application at upazila or district level by selecting Upazila or District from Start process. 

 
Figure 5.3: Starting the Process 
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5.4. Data Quality 

The quality of outputs is dependent upon the quality of data as well as how recent the data is. The current practice of LGED is that data on different parameters of road is updated at different time intervals. It is recommended that all data are updated concurrently. Special care should be taken to update traffic data as both the CBA and MCA analyses use traffic data. RPPM uses two databases of LGED – road database and GIS database. However, these two are not fully integrated. At present, there are limitations in displaying information of all the features contained in the road database. It is recommended that steps should be taken for the full integration of the two databases to overcome the present limitations.  
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Appendix A: Local level workshop 
A.1 Introduction 

 
Most of the data required to run RPPM are available from the road and GIS databases of LGED. 
However, for generating priority lists for road development and core road networks some additional 
data on connectivity, local priority and road safety are needed. Currently these are not available in 
the databases. Local workshops are to be organised to collect these data and facilitate the 
participation of local leaders and other stakeholders in the road planning process. 
 

A.2 Objectives of local workshop 
 
Local workshops are to be conducted at the upazila level. The specific objectives are: 

 to validate and finalize the preliminary core networks at upazila and union levels  
 to identify local priorities of road development considering SDG 9.1 targets 
 to collect data on connectivity and road safety. 

The local level workshops complement the technical process of planning; show transparency in the 
decision-making process, ensure local ownership of the output and overcome the limitations of data 
available in the databases. 
 

A.3 Organisation of workshop 
 
The initiative for organising local workshops may be taken by the concerned office at the LGED HQs 
or by the Executive Engineer (XEN) at the district level. The XEN may advise Upazila Engineers of the 
district on the purpose and tasks to be undertaken at the workshops, and logistic support required. 
The Upazila Engineer in coordination with the XEN will take the main responsibility for organisation 
workshops, one for each upazila in the district.  
 
The Upazila Engineer will fix a date for the workshop in consultation with the local M.P., Upazila 
Chairman, the Upazila Nirbahi Officer (UNO) and the XEN. The XEN/Upazila Engineer in consultation 
with Upazila Chairman will send letters of invitation to workshop participants. Local MP, Upazila 
Chairman and Vice Chairmen, UNO, Chairmen of unions under the upazila, councillors of Upazila 
Union Parishads, concerned officials and other stakeholders may be invited to participate. The UP 
Chairmen and at least one male and one female member from all Union Parishads should be present 
at the workshop. If possible, the XEN of the district should be present. 
 
Prepare all workshop materials in advance and make them available to workshop participants. Give 
due care and consideration in conducting the workshop so that the participants can freely discuss 
and undertake the tasks. The Upazila Engineer and his staff will help the participants to understand 
and to do the tasks. 
 
The workshop venue should hold about 30 people; preferably at the premise of Upazila Parisad. If 
available, arrangements can be made for a computer and projector for easy deliberations. There 
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should be arrangements to hang large size maps. Where possible, consider alternative power supply 
arrangements and facility for printing and photocopying. 
 

A.4 Workshop materials 
 
The Upazila Engineer will prepare the following workshop materials: 

 a (power point) presentation on objectives and tasks of workshop; 
 preliminary maps of Core Road Network at upazila and unions levels; 
 a list of all Upazila and Union roads, and lists of village roads by union; and 
 data collection forms. 

A large upazila map showing roads and other features, if available, can be very helpful for the 
participants to understand the overall context of the upazila especially connectivity with 
neighbouring upazilas. 
 
The power point presentation should focus on the objectives and tasks to be performed in the 
workshop. The content of the slides should be in Bangla with necessary pictures and maps.  
 
Core road network 
Two sets of printed copies of preliminary core network maps are required: 
i. map of preliminary core network for the upazila 

- at least one A0 size map in the scale 1:150,000, and  
- copies of same map on A4 size paper.  

ii. map of preliminary core network for each union 
- at least three maps printed on A4 size paper in the scale 1:45,000. 

  
Road lists 
Two sets of printed road lists using information from the road inventory database will be necessary. 

i. two copies of a union wise road list for each union 
ii. three copies of an upazila wise road list. 

 
A.5 Activities in the workshop 

 
Before the start of the workshop, the XEN/Upazila Engineer should brief the M.P., Upazila Chairman 
and UNO the purpose and tasks to be undertaken at the workshop.   
The Upazila Engineer may consider to distribute (a folder with) the following materials to each 
workshop participant. 

 An A4 size map of core road network of the upazila  
 A list of roads of the upazila 
 An A4 size map of a union core road network to the concerned participants of the union 
 A list of village roads in a union to the concerned participants of the union  

The first two items may be given only to the Honourable MP, Upazila chairman, vice chairmen and 
other members of the Upazila Parishad. 
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There can be a short opening session. At this session the XEN/Upazila Engineer will make a short 
presentation on the purpose and tasks to be undertaken at the workshop.   
The next session will be the working session. The concept of core road network is to be explained by 
the Upazila Engineer using a presentation. After the presentation the following tasks are to be 
conducted: 

 addition or removal of roads in the preliminary core network and validation of core network 
 identifying the level of local priority considering SDG 9.1 target set by LGED and other local 

matters for all roads in an upazila. 
 
Any proposal for addition or removal of a road from the core networks should be discussed by the 
participants and agreed.  Concerned participants may put their stamp of approval to their respective 
finalised core networks. 
 
The MP (if present), Upazila Chairman and Upazila Vice Chairmen and Upazila Parishad members 
may be given the list of upazila and union roads to consider the local priority for the development of 
these roads.  The Union Parishad Chairman and members are given the list of village roads for their 
respective unions.  
 
Participants will determine priority for each of the roads. They put a value (3 for the highest, 2 for 
medium and 1 for the lowest priority) for each road in the list given to them. They may consider 
factors such as SDG 9.1 target, their perception, local knowledge and any other matter of local 
importance.  
 
Once the tasks are completed, LGED officials will ensure that all lists are collected.  
 

A.6 Other activities 
 
At the workshop, the Upazila Engineer and his staff in consultation with concerned participants will 
fill the checklist (Appendix B) to determine connectivity status of all roads. If an Upazila road is 
directly connected to national and regional highways of RHD, zila and upazila headquarters it would 
be given a value of 1 (One); if not it would get 0 (Zero). Similarly, if a Union road connects the upazila 
headquarters it would be given 1 (one); if not it would be given value of 0 (zero). If a village road is 
considered as part of core network, then it gets value of 1(one) otherwise a village road would be 
given value 0 (zero).  
 
RPPM needs road safety data in the form of whether the design of road is safe or unsafe. This data 
would be provided by the Upazila Engineer. However, consultation with concerned participants may 
be necessary. The format of data collection for this item is also provided in Appendix B. If the road is 
safe then a value of 0 (zero) and for unsafe road 1(one) would be given. 
 
The Upazila Engineer will ensure the following outcomes of the workshop. 

 Verified Upazila and Union core road networks 
 Identified Upazila, Union and village roads that have local priorities for development, 
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 Required additional data to update the road database for running RPPM.  
 
The Upazila may also prepare a workshop report. The report along with the information collected/ 
verified at the workshop are to be sent to the LGED headquarter/XEN’s office for follow-up actions 
for including them in the road database. 
  



Planning and Prioritisation of Rural Roads in Bangladesh 

Page48 
  

Appendix B: Survey forms to be Used Data Collection 
 

Survey form for Connectivity and Prioritization of Upazila Road 
 Date:_______________  Name of the Union:_____________________________  Name of the Upazila:____________________________  Name of the Districts:___________________________   

Road Id  Road Name Connectivity Score Priority 
Score‡ 

Is the road 
safe? 

Remark 
Is the Upazila road directly 
connects to national and regional 
highways of RHD, zila and upazila 
headquarters* 

  Yes (1) No (0) Yes 
(0) 

No 
(1) 

 

        
        
        
        

 
 
 
 
 
 
 
 
______________________________ 
Name with Seal 

*Yes (1) refers to a connectivity score of 100 and No (0) 
refers a score of 80. In the form as applicable only ‘1’ or 
‘0’ should be recorded 
‡ Value to be put for Priority Score 3 for highest priority 2 for medium priority 1 for low priority 
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Survey form for Connectivity and Prioritization of Union Roads 
 Date:_______________  Name of the Union:_____________________________  Name of the Upazila:____________________________  Name of the Districts:___________________________   

Road Id  Road Name Connectivity Score Priority 
Score‡ 

Is the road 
safe? 

Remark 

Is the Union Road 
connects upazila 
headquarters? * 

Yes 
(0) 

No 
(1) 

 

  Yes (1) No(0)     
        
        
        
        

 
 
 
 
 
 
 
 
 
______________________________ 
Name with Seal 
  

*Yes (1) refers to a connectivity score of 50 and No (0) 
refers a score of 40. In the form as applicable only ‘1’ or 
‘0’ should be recorded 
‡ Value to be put for Priority Score 3 for highest priority 2 for medium priority 1 for low priority 
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Survey form for Connectivity and Prioritization of Village Roads 
 Date:_______________  Name of the Union:_____________________________  Name of the Upazila:____________________________  Name of the Districts:___________________________   

Road Id  Road Name Connectivity Score Priority 
Score‡ 

Is the road 
safe? 

Remark 
Is the road part of core road 
network? 

  Yes (1) No (0) Yes 
(0) 

No 
(1) 

 

        
        
        
        

 
 
 
 
 
 
 
 
 
______________________________ 
Name with Seal 
  

*Yes (1) refers to a connectivity score of 35 and No (0) 
refers a score of 0. In the form as applicable only ‘1’ or ‘0’ 
should be recorded 
‡ Value to be put for Priority Score 3 for highest priority 2 for medium priority 1 for low priority 
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